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  The Trade-Offs


  Many students find it more convenient to use their own computers rather than the machines in the UW CSE instructional labs in the basement of the Allen Center. But the labs already have all the necessary software for CSE 331 installed and configured correctly. While you are welcome to use your own machines and the staff will help to an extent that is feasible for us, it can be difficult to predict and debug every installation/configuration problem.


  In the end, the staff, given our limited time, may have to advise you to use the department resources if you are having too much trouble installing your own software. Helping with configuration on your own machine is lower priority than helping students with homework questions, getting grading done, etc. We probably cannot help with software other than Eclipse and the other tools used in the course.


  Note that no matter where you work, you will need to remotely log in to the department machine attu to validate your homework submissions in order to make sure you turn in the correct files and your programs compile and run the tests using the compiler and tools the staff will use for grading. Be sure to do this enough in advance of deadlines to avoid issues.


  The Four Main Options


  
    	You can do your work in the Allen Center labs. With this option, there is no software to install and you can proceed directly to learning how to use version control, Eclipse, etc. The only part of the instructions below you need is about logging into attu.


    	You can install the department's home virtual machine on your own computer following the department's instructions. This essentially puts a copy of the lab's Linux installation on your own computer, even if your computer does not otherwise have Linux, combining the convenience of your own computer with the department-installation of the labs. As with working in the labs, all that remains is logging into attu as needed.


    	You can do all your work by logging into attu and using it remotely. This should work, but attu is a shared and remote machine, so you may find large programs like Eclipse run slowly.


    	You can install Java, Eclipse, Subversion, and other necessary tools on your own computer. Most of the instructions below are for this option.

  




















  To be clear, you can skip Steps 1, 2, and 3 below unless you are taking the last option.

  Step 1: Get Oracle's Java Development Kit (JDK)


  You want to download Oracle's J2SE v7.0 JDK from their web site. This is somewhat tricky because there are a lot of things on the download page with nearly the same name. For example, the JRE is the Java Runtime Environment which lets you run Java programs, but does not provide the tools for Java development.


  Thus, go to http://www.oracle.com/technetwork/java/javase/downloads/ and make sure that you follow the link labeled Download JDK. Be sure to get the latest version of Java 7, not Java 8, for 15sp quarter.


  Step 2: Get Eclipse


  You can download a copy of Eclipse 4.4.1 for your machine at http://download.eclipse.org/eclipse/downloads/ if you want the basic installation or https://www.eclipse.org/downloads/ for the “Java Developer” version that has some additional tools (none of which we will depend on in CSE 331). You are also welcome to use the lab machines which also have Eclipse installed.


  Where to Put Eclipse on Your Machine


  Eclipse does not come with an installer, so this confuses many people. Basically, you download it, unzip it into a directory, and then run the executable in that directory to start Eclipse. There are some small bugs in Ant within Eclipse that manifest themselves if it is installed in a directory with spaces in its name, so instead of installing it into a directory such as:


  C:\Documents and Settings\Joe User\Desktop\eclipse



  or


  C:\Program Files\eclipse



  use:


  C:\eclipse



  Setting the JDK in Eclipse on Windows


  If you are using Windows, setup your Eclipse workspace to use the JDK as described in the Tools: Editing, Compiling, Running, and Testing Java Programs handout.


  Step 3: Use SVN


  Eclipse




  We recommend the Subclipse SVN Plugin for Eclipse to manage the assignments. Please follow the instructions mentioned below. But if you get stuck, please refer to the official installation instructions


  Installing Subclipse


  Windows users will need to download SSH clients (if they haven't already) before the Subclipse Plugin. SSH clients include TortoiseSVN and PuTTY. After you install these, install Subclipse as described below and continue the rest of the set up process. This is done to prevent a common Subclipse error: "SVN Cannot Create Tunnel." For additional information refer to this blog post.


  To install Subclipse:


  
    	Open Eclipse (As mentioned in the Eclipse section above, please use Eclipse 4.4.1)


    	Go to Help->Install New Software


    	Click Add in the window that opens up


    	For the Name field: put "Subclipse"


    	For the Location field: put "http://subclipse.tigris.org/update_1.10.x"


    	Hit ok


    	Two checkboxes will appear for Subclipse and SVNKit. Check them both


    	Hit Next and Agree and Finish the installation


    	Restart Eclipse once that is done

  




  Subclipse is a handy tool: it has nice features and is integrated into your development environment. However, it is also buggy. If you have trouble with it, don't get frustrated or stuck. The command-line tool svn tends to be more reliable, and you should feel comfortable using it as well. It works on all operating systems. Another option, which is also more reliable than Subclipse, is TortoiseSVN, which works only on Windows computers.


  After installing Subclipse, you should be able to access your SVN repository.  


  Command Line


  The command line should function the same as in the Allen Center software labs, with the exception that when you checkout, you must specify the repository URL as svn+ssh://YourCSENetID@attu.cs.washington.edu/projects/instr/15sp/cse331/YourCSENetID/REPOS. For example, to checkout the cse331 directory you should run:


  svn checkout svn+ssh://YourCSENetID@attu.cs.washington.edu/projects/instr/15sp/cse331/YourCSENetID/REPOS/cse331 cse331





  Logging in to attu with SSH


  attu is the name of an Instructional Workstation (IWS) Linux machine. You will occasionally need to log into this machine. How you log into attu depends on whether you are starting from a Linux machine or a Windows machine.


  SSH on Linux


  
    	Obtain a command prompt (a.k.a. a terminal or console). You can do so by clicking on Applications -> System Tools -> Terminal.


    	At the command prompt, run the following command: 

      ssh YourCSENetID@attu.cs.washington.edu



    Use the same password you use to login to the Linux machines in the Allen Center software labs.


    Note for those who are new to the command line): When you try to type passwords in the command line, you may be alarmed that you can't see any text entered. To protect your password your typing simply isn't being shown. Just type your password as normal and press enter.


  


  If you are using the Linux machines in an Allen Center software lab, you can alternatively use a shorter version of the command:


    ssh attu



  This works because the username defaults to the username you are currently logged in with and the target domain defaults to the domain of the machine you are connecting from.




  SSH on Windows


  
    	From a CSE instructional machine: Double-click on the SSH attu shortcut on the Desktop.
 If the shortcut is not on your Desktop, go to: All Programs ? UNIX Connectivity ? SSH ? SSH attu in the start menu.


    	From home: 

    
      	Install an SSH client. A great (and free) one is PuTTY.


      	Using PuTTY, connect to attu.cs.washington.edu by entering it in the Host Name textbox and clicking Open. You will be prompted for your username and password.

    


  


  In either case, your username is your CSENetID, and your password is the same one you use to login to the Linux machines in the Allen Center software labs.


  Server Authentication Warning


  The first time you connecting to attu from a given machine, you will receive a server authenticity warning like this:


    The authenticity of host 'attu.cs.washington.edu (128.208.1.139)' can't be established.



  Along with the warning, the SSH client will display the RSA key fingerprint of the remote host so that you can verify the host's identity. It is safe to say "yes" to continue connecting. When you connect, SSH will cache the host key in order to automatically verify the remote host's identity in the future.




  File Transfer: SCP


  If you only want to transfer files between your CSE account and your home machine, you can use scp ("secure copy"). For CSE 331, you should rarely, if ever, need to manually transfer files. All your code and other homework materials will be in a Subversion repository, allowing you to automatically and safely synchronize your work across machines. We provide information about scp as a reference for your general knowledge.


  On a Mac or Linux machine, you can run scp at the command line. Run man scp for documentation on this command. If you prefer a graphical interface or if you are using Windows, you can install a file transfer program such as WinSCP. Most of the directions above for establishing a remote connection via ssh also apply to scp.
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  Using the Unix Command Line


  A few CSE 331 tasks require connecting to a Linux machine and running some commands from the command-line. To understand the instructions may require some basic understanding of how to use a shell to perform command-line actions. This material is covered (in more depth than we need) in CSE390A, which has materials posted online. Alternately, you can read the Unix tutorials provided by the student ACM chapter. While these tutorials are old and have some dated information about machine names and such, the basics of the Unix command line have not changed in decades.




  Starting Eclipse


   If you are working on your own computer, you should have installed Eclipse. Else, it is installed on the department machines (and virtual machine). 




  Starting Eclipse on Linux


  Type this at the prompt to start Eclipse on Linux:


  eclipse &


  


  Eclipse will start up, display a splash screen, and then show a workplace selection dialog:


  
    [image: Screenshot: Eclipse Workspace Selection]
  


  Eclipse is asking you which workspace folder to use for this session. In response, if in the department labs, type:


  /homes/iws/YourUserName/workspace331



  where YourUserName is your UW CSE username. (Note: Do not enter "~/workspace331" for this step. Eclipse does not recognize the '~' character.) On your own machine, you can choose where to put your workspace.


  If Eclipse shows the welcome screen, containing only the text "Welcome to the Eclipse IDE for Java Developers" on a pretty background, switch to the code editor by going to Window > Open Perspective > Other... and selecting Java (default).


  Starting Eclipse on Windows


  From the start menu, goto: All Programs ? DEV TOOLS & LANGUAGES ? Eclipse ? eclipse.


  Eclipse will start up, display a splash screen, and then show a workplace selection dialog:


  
    [image: Screenshot: Eclipse Workspace Selection in Windows]
  


  Eclipse is asking you which workspace folder to use for this session. In response, type:


  Z:\workspace331



  This directory will work on the lab Windows computers; adjust it as needed if you are working on your personal computer.


  Eclipse preferences




  Go to Window(or Eclipse in OS X)->Preferences->Java->Code Style->Formatter. Then hit Edit. In the Comments tab, unselect the "enable block comment formatting" checkbox.


  Setting the JDK in Eclipse on Windows


   To use the Ant buildfile, you need to tell Eclipse to use the Java JDK (development kit) instead of the JRE (runtime environment).


  
    	In Eclipse, goto  Window ? Preferences  to open the Preferences dialog.


    	In the left pane of Preference dialog, select  Java ? Installed JREs 


    	Click the Search... button in the Installed JREs pane


    	In the directory selection window that appears, select  C:\ ? Program Files ? Java  as shown in the screenshot below.

    [image: Screenshot: Searching for JREs]



    	Click OK




    	In the Installed JREs list, check the box next to jdk1.7.0_04 (or any version that starts with jdk1.7) and click OK

    [image: Screenshot: Selecting jdk1.7]



    	If Eclipse shows the welcome screen, containing only the text "Welcome to the Eclipse IDE for Java Developers" on a pretty background, switch to the code editor by going to Window > Open Perspective > Other... and selecting Java (default).

  


  Eclipse generics errors configuration


  We expect your code to not have any generics-related problems. For example, the following code is unacceptable:


  List myList = new ArrayList();
myList.add("foo");



  The generic type List of myList should be parametrized, for instance, to String by replacing the first line with List<String> myList = new ArrayList<String>(); Note that List<String> myList = new ArrayList(); is also incorrect.


  By default, Eclipse shows generics problems as warnings (indicated by yellow lines and markers). You can configure Eclipse to instead issue errors (indicated by red lines and markers) for these problems. Doing so will help you remember to write acceptable generics code.


  To make this configuration, go to Windows ? Preferences and select Java ? Compiler ? Errors/Warnings. Under Generic types, change the value of Unchecked generic type operation to Error.


  (Note that there is another setting named Usage of a raw type that is set to Ignore by default. We recommend leaving this option disabled or set simply to Warn because it is specific to the Eclipse compiler and checks for more stringent requirements than required by the Java language specification. Thus, "Usage of raw type" may complain about issues, that while providing insight about your code, is not checked by Oracle's javac, which is our official standard for compilation errors and warnings in this class.)




  Opening Files; Managing Multiple Files


  Switch to the "Java" perspective in Eclipse if you're not already in it (Window ? Open Perspective ? Other... ? Java).


  You can open multiple files in Eclipse by double-clicking each of them from the Package Explorer pane. Once you have multiple files open, you can switch between them quickly by holding down Ctrl and hitting F6 to bring up a dropdown box of open files, and then using the arrow keys to select the file whose editor you wish to bring into focus. You can also navigate through different files using the tabs on top of the editor pane.




  Creating New Files


  New Java files


  To create a new Java source file (with the .java extension), select from the top menu File ? New ? Class. A window will pop up, asking you details about the class. Leave the source folder as cse331/src, and select a package (e.g. hw1). Choose a name for your class (e.g. MyClass) Type this name in the "Name" field and click Finish.


  (If you want your new class to be executable, it will need a main method. Eclipse can generate that automatically for you if you check the appropriate checkbox in the New Java Class screen.)


  
    [image: Screenshot: New Java Class]
  


  New Text files


  There is a similar procedure for creating new non-Java files such as text files. Select File ? New ? File. In the resulting dialog box, choose the parent directory of your new file and type the desired filename. If you want to create a new directory, you can do so by appending the directory name in front of your desired filename. For example, if you want to create a file problem0.txt in the directory hw1/answers, but the answers directory does not yet exist, you can choose hw1 as the parent directory, and then type answers/problem0.txt as the file name, and Eclipse will create the new directory and file for you.


  Editing Java Source Files


  Here are some useful actions that you can perform when editing Java code:


  
    	Autocompletion


    	Organizing Imports


    	Viewing Documentation

  


  Autocompletion


  Autocompletion is the ability of an editor to guess what you are typing after you type out only part of a word. Using autocompletion will reduce the amount of typing that you have to do as well as the number of spelling mistakes, thereby increasing your efficiency.


  Eclipse continuously parses your Java files as you are editing, so it is aware of the names of variables, methods, etc... that you have declared thus far.


  CTRL+Space can be used to autocomplete most things inside the Eclipse Java editor. For example, if you have declared a variable named spanishGreeting in the current class, and have typed the letters spanishGree in a subsequent line, Eclipse can infer that you mean to type spanishGreeting. To use this feature, press CTRL+Space while your cursor is at the right of the incomplete name. You should see spanishGree expand to spanishGreeting.


  Eclipse can also help you autocomplete method names. Suppose you have a variable myList of type List, and you want to call the method clear. Begin typing "myList." — at this point, a pop-up dialog will display a list of available methods for the type List, and you can select the appropriate method with the arrow keys. You can force the popup to appear with CTRL+Space.


  Organizing Imports


  You can press CTRL+SHIFT+o to organize your imports in a Java file. Eclipse will remove extraneous import statements and try to infer correct ones for types that you refer to in your code but have not yet been imported. (If the name of the class that needs to be imported is ambiguous – for example, there is a java.util.List as well as a java.awt.List – then Eclipse will prompt you to choose which one to import.)


  Viewing Documentation


  Although you can directly browse the Java 7 API and other documentation at the Oracle website, it is often useful to be able to cross-reference parts of your code with the appropriate documentation from within your editor.
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  Introduction


  You turn in your assignment by committing to your SVN repository. While this is sufficient if all is well, we strongly recommend you then validate your submission to avoid drastic problems where you do not submit your homework correctly.




  validate


  Validating your code checks it for common errors, such as the code you checked in not compiling correctly with the compiler used for grading. Such errors could prevent you from receiving credit for your code, so you should always validate your assignment before you complete it.  However, validation is not guaranteed to catch all errors in your code.


  You should validate your assignment by running ant validate on attu (and making sure that it completes successfully!) by running the commands below.


  You can log in to attu via SSH from any machine. (Even if you are working on an Allen Center Linux machine you still need to SSH into attu.)


  cd ~/workspace331/cse331/src/hwN/
ant validate



  or


  cd ~/cse331/src/hwN/
ant validate



  You need to select the correct version depending on where you have checked out your copy of your Subversion repository. If you have not yet checked out your repository on a CSE Linux machine (say, because you work on Windows or at home), then you must first check out your repository using the command line. Note that if you check out your working copy in the location suggested there, the path to your project (as listed in the directions above and in the ouput below) will not include the workspace331/ directory.


  What does this do?


  This checks out a fresh copy of your code (to a temporary directory) and ensures that your implementation:


  
    	contains the required files


    	compiles without errors. This is important because if you are not working in the Allen Center software labs, you may be using a different compiler. You may work wherever you like, but your code must work on attu (and must compile without errors or warnings).


    	passes the student's hwN.test.ImplementationTests and hwN.test.SpecificationTests. (You can optionally read more about the CSE 331 JUnit Framework.)

  


  What is the result?


  If validation was successful, you should see output that looks something like:


  Buildfile: /homes/iws/username/workspace331/cse331/src/hw1/build.xml

validate:
     [echo] Validate checks out a fresh copy of the hw, checks for the
     [echo]       presence of required files, and runs all your tests to make sure
     [echo]       they pass.  This target can only run on the attu IWS machine.
     [echo]
     [echo]       Note: the test reports will be generated under the scratch
     [echo]       directory the validate target creates.
     [echo]
   [delete] Deleting directory /homes/iws/username/workspace331/cse331/scratch
    [mkdir] Created dir: /homes/iws/username/workspace331/cse331/scratch
     [echo] /projects/instr/13sp/cse331/username/workspace331/REPOS
     [exec] A    cse331
     [exec] A    cse331/.classpath
     
     ...
     
     [exec] BUILD SUCCESSFUL
     [exec] Total time: 2 seconds
   [delete] Deleting directory /homes/iws/username/workspace331/cse331/scratch



  If there is an error, the validate script should provide some information about what is wrong:


  Buildfile: /homes/iws/username/workspace331/cse331/src/hw1/build.xml

validate:
     [echo] Validate checks out a fresh copy of the hw, checks for the
     [echo]       presence of required files, and runs all your tests to make sure
     [echo]       they pass.  This target can only run on the attu IWS machine.
     [echo]
     [echo]       Note: the test reports will be generated under the scratch
     [echo]       directory the validate target creates.
     [echo]
     
     ...
     
     [exec] cleancopy:
     [exec]      [echo] Hw directory: /homes/iws/username/workspace331/cse331/scratch/cse331/src/hw1
     [exec]
     [exec] BUILD FAILED
     [exec] /homes/iws/username/workspace331/cse331/scratch/cse331/src/common.xml:106: The following error occurred while executing this line:
     [exec] /homes/iws/username/workspace331/cse331/scratch/cse331/src/common.xml:121: Could not find required file: answers/hw1_answers.pdf
     [exec]
     [exec] Total time: 1 second
     [exec]
     [exec] cleancopy.check:

BUILD FAILED
/homes/iws/username/workspace331/cse331/src/common.xml:160: exec returned: 1






  This error would indicate that a required file, answers/hw1_answers.pdf is missing. Make sure you've committed this file to SVN.


  If the validate output indicates errors, you should fix them before the deadline, or you will lose points on your assignment. If validate failed because the public test suite failed, you can view a summary of the JUnit failures in your YourWorkspaceDirectory/scratch/cse331/src/hwN/test/reports directory.


  Important: be aware that the validation script tests your code against your own test suite. Although by default we populate hwN.test.SpecificationTests with the public test suite, it is your responsibility to retain those tests in hwN.test.SpecificationTests if you want the validatation script to check your code against the public tests.


  Why does this have to run on attu from the command line?


  Most ant targets that the staff supplies should work both in the Allen Center software labs and on your home computer, but ant validate only works on attu. This is because we grade your solutions on attu, so it is important to verify that your code compiles and runs correctly in exactly that environment.


  Eclipse's integrated Ant support does not handle the ant validate target well. Even if you use Eclipse as your development environment, you should validate on the command line as shown above.
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  Introduction


  Eclipse is an integrated development environment with strong support for Java. In addition to various features that facilitate writing Java code (such as autocompletion and code refactoring), it has built-in support for JUnit, and Ant — tools that we use in CSE 331.


  Eclipse (version 4.2) is already installed on CSE departmental machines (and the department virtual machines). See here for how to use Eclipse at home.


  You can read more about and get help on the features of Eclipse in its online documentation.


  Eclipse Quick Reference




  Here are some tips for things that can make your life easier in Eclipse:


  
    
      
        	
          Autocomplete
        

        	
          Ctrl-Space asks Eclipse to help
you complete some code you've started. Eclipse can complete lots
of things:
      

          
            	variables, method names, class names 

            
              	ArrayL Ctrl-Space --> ArrayList


              	random.next Ctrl-Space --> random.nextInt

            



            	constructor and method parameters 

            
              	new ArrayList( Ctrl-Space --> popup menu of ArrayList's constructors


              	random.nextInt( Ctrl-Space --> tooltip showing nextInt's parameters

            



            	methods to override 

            
              	class Foo extends Bar { Ctrl-Space --> menu of Bar's methods that can be overridden

            


          

        
      


      
        	
          Organize import statements
        

        	
          Ctrl-Shift-O (that's O as in
Organize) automatically updates the import statements at the top of
your class, adding classes that need to be imported from other packages
and removing classes that you're no longer using. If a class name
is ambiguous — e.g., List
might be either java.util.List
and java.awt.List — then
Eclipse pops up a dialog asking you which one you want.
        
      


      
        	
          Look up Java API documentation
        

        	
          Shift-F2 when your cursor is on
a class or method name (You have to configure this feature with
the location of the API documentation).
        
      


      
        	
          Comment/uncomment a
block of code
        

        	
          Ctrl-/ comments the highlighted
region.
          Ctrl-\ uncomments the highlighted region.
        
      


      
        	
          Renaming or moving packages,
		classes, methods, and variables (updates all references)
		
        

        	
          Alt-Shift-R (Rename) or Alt-Shift-V (Move) when your cursor is
			  over the package/class/method/variable. Equivalently, right-click on any package,
			class, method or variable in the Package Explorer and select Refactor ? Rename to rename it or
		Refactor ? Move to put it in another package or class.
        
      


      
        	
          Delete current row
        

        	
          Ctrl-D when cursor
		is in row to be deleted.
        
      


      
        	
          Mark TODO items for
yourself
        

        	
          Start a comment with TODO to
leave yourself a note about a piece of code that you need to fix.
Eclipse will automatically put the comment in the Tasks pane, the pane
where it shows your compile errors. (If you don't see the Tasks
pane, use Window ? Show View ? Tasks.) You can jump to TODO
items or compile errors in your code quickly by double-clicking on them
in the Tasks pane.
        
      




      
        	
          Generate get() and
set() methods
        

        	
          Make sure the fields for which
you would like to create get() and set() methods are declared in the
class, then right-click and use Source ?
          Generate Getter and Setter.
        
      


      
        	
          Run classes or unit tests that
you've run recently
        

        	
          The little "play" icon
          [image: ] on
the Eclipse toolbar runs the last class or unit test you just
ran.  Pull down its menu for your recent history of runs.
        
      


      
        	
          Turn off console autoraise
        

        	
          When a program run under Eclipse
      writes to standard out (say, via println), Eclipse raises the
      "console" perspective.  This may be annoying when you run tests, or
      when you use Continuous Testing.  To turn this off, go to
      Window ?
      Preferences ? Run/Debug ?
      Console and uncheck “Show when program writes to
      standard out”.
        
      


      
        	
          Emacs key bindings
        

        	
          If you prefer
to use Emacs key bindings while editing code, do: 


          Window ? Preferences...?
   General ? Keys ? Modify and set
   Scheme to Emacs
        
      

    
  


  Use the right version of the JDK


  If you get an error such as


  java.lang.UnsupportedClassVersionError: utils/tests/LabelledParameterized : Unsupported major.minor version 51.0
     at java.lang.ClassLoader.defineClass1(Native Method)



  while compiling or while running tests, then you are using the wrong version of Java. CSE331 uses Java 7. A common reason for using the wrong version of Java is making a mistake when following our setup instructions, or making an incorrect change to your Eclipse setup since doing so.


  The following might fix the problem:


  Right click your Project ? Properties ? Java Build Path ? Libraries Tab ? Remove the JRE and JUnit Libraries (keep junit-4.11.jar though) ? Click "Add Library" ? JRE System Library ? Workspace default JRE (jdk1.7.0) ? Finish


  
    For problems or questions regarding this page, contact: cse331-staff@cs.washington.edu.
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  Overview


  Coding style is an important part of good software engineering practice. The goal is to write code that is clear and easy to understand, reducing the effort required to make future extensions or modifications.


  In CSE 331 we do not specify a detailed coding style that you must follow. However, we expect your code to be clear and easy to understand. This handout provides overall guidelines within which you should develop your own effective coding style.


  Many other style guides are available. For example, you can see Oracle's Code Conventions for the Java Programming Language or Michael Ernst's document about coding conventions, which complements this document. We do not require you to follow those guidelines slavishly — they are just one way to write your code in a comprehensible fashion — but you might consider them while developing your own style. Even more valuable than coding style guides are descriptions of good ways to design and write code. For Java programmers, Josh Bloch's book Effective Java is an excellent choice.


  Descriptive names


  Names for packages, types, variables, and branch labels should document their meaning and/or use. This does not mean that names need to be very long. For example, names like i and j are fine for indexes in short loops, since programmers understand the meanings and uses of these variables by convention.


  You should follow the standard Java convention of capitalizing names of classes, but starting method, field, variable, and package names with a lower case letter. Constants are named using all uppercase letters. The Java Language Specification provides some common Naming Conventions that you may want to use when naming your classes, methods, etc. Also see Effective Java item #56.


  Consistent indentation and spacing


  Indenting code consistently makes it easy to see where if statements and while loops end, etc. You should choose consistent strategies; for example, be consistent about whether you put the open curly brace on the same line as the if or on the next line, or what your try-catch-finally blocks look like. Examine the staff-supplied code, and the code printed in books, for sample styles; feel free to develop your own if it makes you more comfortable.




  In Eclipse, Ctrl-F will indent your code, according to its built-in indentation rules (which you may or may not like).


  Consistent (and adequate) horizontal spacing also helps the reader. There is no reason to try to save a column or two by eliminating spaces. You should leave a space after the comma that separates method arguments. You should leave a space between for, if, or while and the following open parenthesis; otherwise, the statement looks too much like a method call, which is confusing. In general, you should place only one statement on each line. Remember that people reading your code may have a monitor of a different width, or may choose to print your code for a code review (the TAs may do this!). 80 columns is a commonly-accepted width in industry, and we require this for the convenience of the TAs when marking up your printouts. A longer line once in a while is acceptable, but not as a general rule. When you break lines, do so at logical, not arbitrary, locations.


  Code files should never contain tab characters. They format differently in different IDEs, when printed, etc. A decent IDE should not insert tab characters in code files, or at least should have a setting that uses spaces instead. In Eclipse, do the following:


  
    	Go to Window > Preferences > Java > Code Style > Formatter


    	Create a new profile (if you haven't before -- you can't change the default Eclipse profiles, and they use tabs)


    	Set "Tab Policy" to Spaces only


    	Ctrl+Shift+F will reformat the current file to these settings


    	You can temporarily enable General > Editors > Text Editors > show whitespace to verify that it converts the tabs to spaces.

  


  Local variables


  Local variables should have the smallest possible scope. Don't declare it at the beginning of the method and then have a lot of unrelated code intervening between its declaration and its first use. As another example, if you have a variable that is used within each loop iteration, declare it inside the loop to make clear to readers that there are no loop-carried dependencies.


  Also see Effective Java item #45.


  Types


  Generics


  A type parameter must be supplied whenever a generic type is used. Never use a so-called "raw" type such as List, but instead use List<Integer> or the like.


  All code must compile without warnings using javac -g -Xlint, without use of @SuppressWarnings except as permitted below.


  Type casting


  As a general rule, you should never have type casts in code you write (especially that for CSE 331). Casts are a work-around that hides information from the type system and prevents the compiler from flagging real bugs in your code.


  However, there are some over-broad legacy interfaces in the Java library that require the use of casts. These were, in general, written in Java's dim past before it had the powerful type system it has today — some of these interfaces are quite widely used, however. Implementing these “over-broad” interfaces is an acceptable reason to use type casts.


  The following is a fairly complete list of interfaces in the Java API that require casts. Unless you are implementing one of these, there should probably be no type casts in your code:


  
    All implementations of:


    
      	Object.equals()

    


    Some (not all) implementations of:


    
      	Object.clone()


      	Collection.contains() (and subclasses of Collection, like List and Set)


      	Collection.remove() (and subclasses)


      	Map.containsKey()


      	Map.containsValue()


      	Map.get()


      	Map.remove()


      	JComponent.paintComponent (casting the Graphics object is encouraged in the official Oracle tutorial)

    


    These may require unchecked casts (even worse!):


    
      	SortedMap.containsKey()


      	SortedMap.containsValue()


      	SortedMap.get()


      	SortedMap.remove()


      	SortedSet.contains()


      	SortedSet.remove()

    

  


  CSE 331 requires that your code compile cleanly when javac is run with the -Xlint flag. You may use the @SuppressWarnings("unchecked") annotation to suppress warnings about unchecked casts in the last list of methods above.  Additionally, if the official Oracle Java tutorials tell you to use a cast, it's okay. Other than that, you may not use @SuppressWarnings in your code. And, whenever you use one, do document your justification.


  Informative comments


  Don't make the mistake of writing comments everywhere — a bad or useless comment is worse than no comment. If information is obvious from the code, adding a comment merely creates extra work for the reader. For example, this is a useless comment that would only help someone who does not know the programming language:


  i++;    // increment



  Good comments add information to the code in a concise and clear way. For example, comments are informative if they:


  
    	Enable the reader to avoid reading some code. The following comment saves the reader the effort of figuring out the effect of some complicated formulas, and states the programmer's intention so the formulas can be checked later on. 

        // Compute the standard deviation of list elements that are
    // less than the cutoff value.
    for (int i=0; i<n; i++) {
        ...
    }



    An important application of this type of comment is to document the arguments and return values of methods so clients need not read the implementation to understand how to use the method.



    	Explain an obscure step or algorithm. This is especially important when the effects of some step are not immediately obvious in the code itself. You should explain tricky algorithms, operations with side effects, magic numbers in the code, etc. 

        // Signal that a new transfer request is complete and ready
    // to process.  The manager thread will begin the disk transfer
    // the next time it wakes up and notices that this variable has changed.
    buffer_manager.active_requests ++;




    	Record assumptions. Under what assumptions does a piece of code work properly? 

        // The buffer contains at least one character.
    // (If the buffer is empty, the interrupt handler returns without
    // invoking this function.)
    c = buffer.get_next_character();




    	Record limitations and incomplete code. Frequently, the first version of code is incomplete; it is important to record which code is known to be incorrect. If you run out of time on an assignment and turn in a program that does not function correctly on all inputs, we will expect your code to show that you understand its limitations. 

        if (n > 0) {
        average = sum / n;
    } else {
        // XXX Need to use decayed average from previous iteration.
        // For now, just use an arbitrary value.
        average = 15;
    }



  


  Hints:


  
    	Don't write code first and then comment it — comment it as you go along. It is easier to comment it while you are thinking about it and still remember its details, and you are unlikely to go back and do it later. In fact, it's best to comment the code before you write it — doing so may expose weaknesses in your ideas and save you time on the implementation.


    	We do not require you to write comments on every program piece. However, your grade depends substantially on the clarity of your code, and some piece of the program that seems clear to you may not be clear to the reader. Therefore, we strongly recommend that you add explanatory comments to all classes, fields, and methods, especially public ones — it will likely be to your advantage to do so.

  


  Javadoc comments


  Every class, every interface, every public method and field, and every nontrivial non-public method and field, should have an explanatory Javadoc comment. (Javadocs are useful even on non-public members, for two reasons. First, Javadoc has a special option that causes it to output documentation for all members, including private ones. You would never supply this to your clients, but it sure is helpful for the development team to have this handy. Second, an IDE such as Eclipse displays the Javadoc for a member when you hover over a use, and this is as useful for private and public members.)




  Comments should be grammatical English. If more than a few words, a comment should consist of complete sentences that start with a capital letter and end with a period.


  HelloWorld from HW3 has several Javadoc comments: at the top of the file, before the class declaration, before the greeting field, and before each method. You can tell that these are Javadoc comments because of where they appear in the code and because they start with /** instead of /*.


  It is important to use this syntax to document your code so that your comments will appear in the HTML documentation generated by the Javadoc tool (this is how the documentation for Oracle's API is generated, as well). There are a number of Javadoc Tags that get formatted in a special way when the HTML documentation is generated. You can identify these tags because they start with the @ sign, such as @param and @return.


  For CSE 331, we use a few additional Javadoc tags that are not recognized by Oracle's Javadoc tool, such as @requires, @modifies, and @effects. So we need to use a special 331-specific version of Javadoc, which is described elsewhere.


  When someone else (such as your TA) is trying to understand your Java code, he or she will often first look at the generated Javadoc to figure out what it does. Thus, it is important that you check the generated HTML yourself to ensure that it clearly and accurately communicates the contracts of your code.


  TODO comments


  If you want to leave yourself a note about a piece of code that you need to fix, preface the comment with TODO. You will notice that TODO will appear in bold and that if you do Window > Show View > Tasks, then a “Tasks” pane will come up with all of the things you have left yourself TODO. You can jump to these points in your code quickly by double-clicking on them in the “Tasks” pane.


  Commenting out code


  Sometimes, you want to temporarily or permanently comment out some code.


  Java has two ways to write comments: /*...*/ comments out everything between the comment delimiters, and // starts a comment that ends at the end of the line. You should use // to comment out code. Reserve /*...*/ comments for Javadoc comments, in which case the opening tag should have an additional asterisk: /**.


  In Eclipse, you can comment out a block of code by highlighting the region and pressing Ctrl+/. Use Ctrl+\ to uncomment code in Eclipse.


  The rest of this section explains why you should use line comments such as // instead of block comments such as /*...*/: because block comments do not nest. For example, if you already did:


  String a = "The HUB "; String b = "bites";
/* String b = "brings me happiness"; */
String c = "closes? Nope. Never.";
String d = "doesn't have anywhere to sleep comfortably.";



  But then you wanted to comment out the creation of variables b and c using a block comment, you would have:


  String a = "The HUB ";
/* String b = "bites"; /* String b = "brings me happiness"; */
String c = "closes? Nope. Never.";
*/
String d = "doesn't have anywhere to sleep comfortably.";



  (The two block comment characters that have been added are in red and the code that is commented out by the new block comment is underlined.) Notice that this failed to comment out the statement where c is created. Also, this code will no longer compile because there is a */ dangling by itself after the definition of c. This may seem easy to fix now, but if you have commented a large block of code, it may be a pain to find the nested block comment that is causing the compilation error. You can avoid this mess entirely by using the // comment:


  String a = "The HUB ";
// String b = "bites";
// // String b = "brings me happiness";
// String c = "closes? Nope.  Never.";
String d = "doesn't have anywhere to sleep comfortably.";



  This also makes it easier to uncomment smaller blocks of commented regions.


  Documenting Code




  Specification-level comments


  Abstract data types. Every abstract data type (class or interface) should have:


  
    	An overview section that gives a one or two line explanation of what objects of the type represent and whether they are mutable.


    	A list of specification fields. There might be only one; for example, a set may have the field elems representing the set of elements. Each field should have a name, a type, and a short explanation. You may find it useful to define extra derived fields that make it easier to write the specifications of methods; for each of these, you should indicate that it is derived and say how it is obtained from the other fields. There may be specification invariants that constrain the possible values of the specification fields; if so, you should specify them.

  


  Method Specifications. All public methods of classes should have specifications; tricky private methods should also be specified. Method specifications should follow the requires, modifies, throws, effects, returns structure described in the course material on specifications.  Note that for CSE 331, you may assume arguments are non-null unless otherwise specified.


  Implementation-level comments


  Implementation notes. Class comments should include the following elements: 


  
    	An abstraction function that defines each specification field in terms of the representation fields. Abstraction functions are only required for classes which are abstract data types, and not for classes like exceptions or some GUI widgets.


    	A representation invariant. RIs are required for any class that has a representation (e.g., not most exceptions). We strongly recommend that you test invariants in a checkRep() method where feasible. Take care to include in your invariants assumptions about what can and cannot be null.


    	For classes with complex representations, a note explaining the choice of representation (also called the representation rationale): what tradeoffs were made and what alternatives were considered and rejected (and why).

  


  Runtime assertions. These should be used judiciously, as explained in lecture. For a longer discussion of the how runtime assertions can improve the quality of your code, see Writing Solid Code by Steve Maguire, Microsoft Press, 1995.
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  [bookmark: Introduction]Introduction


  This handout describes how to document the specifications of classes and methods. This document focuses on practical issues.


  This document uses a Line class as an example. We do not provide fields or method bodies in our example. This document covers specifying the behavior of classes and methods (what they should do), not their implementation (what they actually do and how they do it).


  Abstraction Functions and Representation Invariants covers how to document a class's implementation.


  [bookmark: LineDef]
/**
 * This class represents the mathematical concept of a line segment.
 *
 * Specification fields:
 *  @specfield start-point : point // The starting point of the line
 *  @specfield end-point   : point // The ending point of the line
 *
 * Derived specification fields:
 *  @derivedfield length : real // length = sqrt((start-point.x - end-point.x)^2 + (start-point.y - end-point.y)^2)
 *                              // The length of the line
 *
 * Abstract Invariant:
 *  A line's start-point must be different from its end-point.
 */
public class Line {

  ... // Fields not shown.

 /**
  * @requires p != null && ! p.equals(start-point)
  * @modifies this
  * @effects Sets end-point to p
  */
  public void setEndPoint(Point p) {
    ...
  }

  ...

}



  Because several concepts discussed here are interrelated, let's starts with a short list of definitions before diving into the details.


  
    	Abstract Value


    	What an instance of a class is supposed to represent. For example, each instance of Line represents some line segment.


    	Abstract State


    	The information that defines the abstract value. For example, each abstract line has a start point and an end point.


    	Specification Fields


    	Describes components of the abstract state of a class. For example, the abstract state of a Line is made up by the specification fields start-point and end-point.


    	Derived Specification Fields


    	Information that can be derived from specification fields but is useful to give a name to. For example, Line has the derived field length, which describes the length of the line segment.


    	Abstract Invariant


    	A condition that must stay true over the abstract state of all instances of a class. For example, Line requires that no instance has the same start and end point. Abstract invariants are expressed in terms of the abstract state. Note that this is not the same as the Representation Invariant (RI) that describes properties of the concrete representation. An abstract invariant, if one is present, specifies constraints on abstract values only.


    	Method Specifications


    	Describe a method's behaviors in terms of abstract state. For example, Line's setEndPoint method updates the end-point specification field.

  


  The above concepts are included in a class's external specification (in Javadoc). They help document for clients how to use the class.


  The rest of this document is organized as follows. First, it explains how to document what a class abstractly represents using abstract state, specification fields and derived fields. Then, it explains how to specify method behavior, in terms of abstract state.


  [bookmark: AbstractValuesAndAbstractState]Abstract Values and Abstract State




  The abstract value of an object is the information that clients use when reasoning about an object. For example, a line segment is defined in terms of a start point and an end point. This does not necessarily imply that the concrete reprsentation of the object has two point fields. That is one representation, but there are others, such as a start point, an angle, and a length. Abstract values are typically at a less detailed level than an implementation because this helps clients reason about only what matters to them. For example, clients of some representation of strings just need to know that a string is a sequence of characters, not whether that sequence is implemented with an array, a linked list, a combination of the two, or some completely different way. The notion of sequence is more abstract than particular ways to reprsent sequences.




  [bookmark: MAV]Mathematical Abstract Values


  For some ADTs, the abstract values are well-described by concepts and notation that are common in mathematics and well-understood by software developers. Examples include:


  
    	a set of integers


    	a sequence of characters (i.e., a string)


    	a pair of real numbers (or a triple, or in general a tuple)

  


  If you are specifying such a class, then you're in luck. You can use conventional notation for specifyng the class's abstract values and methods. Such notation includes:


  
    	set comprehension: { x | P(x) } denotes the set of all elements x that satisfy the property P. More generally, { f(x) | P(x) } denotes the set of values of the expression f(x) for all x that satisfy the property P. For example,  { x * x | x > 10 }  represents the set of all numbers whose square root is greater than 10.


    	set union: x ∪ y denotes the union of two sets x and y. (This can also be written x + y when there's no danger of confusion with addition.)


    	set membership: a ∈ x or a in x tests whether a is an element of the set x.


    	sequence construction: [a, b, c] denotes a sequence of three elements.


    	sequence concatenation: x : y denotes the concatenation of two sequences x and y. (This can also be written x + y when there's no danger of confusion with addition or union.)


    	sequence indexing: x[i] denotes the ith element of a sequence x.


    	set or sequence size: |x| denotes the number of elements in a set or sequence x.


    	tuple construction: <a, b, c> is a tuple of three elements. This is also written (a, b, c). Unlike sequences, tuples are fixed-length, so we don't normally think about concatenating them.

  


  You aren't obliged to use this syntax. Some of it is more standard than the rest: set-comprehension syntax is standard in just about all of mathematics, but sequence concatenation isn't particularly standardized. You may find it clearer to write sequence concatenation as a function like concat(x, y). What really matters is clarity and lack of ambiguity, so if you have any doubt whether your reader will understand you, just define it: “...where concat(x,y) is the concatenation of two sequences x and y.”


  [bookmark: SpecificationFields]Specification Fields


  Usually, abstract values are not only simple mathematical objects like numbers or sets. In these cases, it's more useful to think about the abstract value as if it were an object with fields. For example, a line has a start and an end; a mailing address has a number, street, city, and zipcode; and a URL has a protocol, host name, and resource name.


  Mathematically, this is the same as a tuple; it's just a tuple whose parts have useful names for humans, rather than simply parts in some order without names. So even though we could use tuples, it's convenient, and more readable, to break the abstraction state into named parts, where each part is a specification field. (Specification fields are more commonly called abstract fields, because they're fields of the abstract value, as opposed to rep fields which are fields of the representation value. Unfortunately, abstract has another meaning in Java, so we will avoid that potentially confusing terminology.)


  Specification fields often (but not always) correspond to observers or getters on the abstract data type. Because the structure of abstract values is a matter of interest to the clients of your class, the specification fields should be listed in the class overview. In CSE 331, we have a Javadoc convention for describing them: @specfield name : type // description. Here's an example:


  /**
 * Represents an appointment for a meeting.
 * @specfield date : Date         // The time
 * @specfield room : integer      // The room number of the meeting's location
 * @specfield with : Set<Person>  // Whom the appointment is with
 */
 class Meeting {



  By convention, in specification fields, lowercase types like sequence or set refer to mathematical entities. Capitalized types refer to other ADTs (classes or interfaces). Where you have a choice, prefer a mathematical entity as the type of a spec field; it is better to use sequence than List, for example. It's more elegant, and reduces the coupling between your specification and particular Java types.


  The presence of a specification field does not imply anything about the interface or implementation of the class. Although spec fields often correspond to observer methods, that's not always true. (An observer method is one that computes a value without performing any side effects. All getter methods are observers, but not all observers are getters.) The interface might not provide any observers that query the spec field's state, so clients of the class might not have access to the information stored in the spec field. (An example is that a stack implementation might have a spec field for the elements of the stack, but a client might only be able to push and pop rather than being able to obtain the full state of the stack.) Likewise, the implementation might not actually have a concrete field of the spec field's type: that information may be computed from multiple concrete fields, or it might not be available at all. The point is that specification fields are useful for giving method specifications in terms of the abstraction being provided.


  [bookmark: DerivedFields]Derived Fields


  Derived fields are information that can be derived from the specification fields that it is useful to give a name to. For example, consider this class:


  /**
 * Represents a square.
 * @specfield length : int // The length of the square's sides
 * @derivedfield area : int // area = length^2. The area of the square
 *
 * Abstract Invariant:
 *  length > 0
 */
class Square {...}



  The derived field area can be derived by squaring the length specification field. A derived field's documentation should state how it is derived from the specification fields.


  A derived field's purpose is to help with writing method specifications, abstraction functions, and representation invariants: It is easier to write and understand area than length^2.  They are a shorthand that can make class and method specifications easier to understand. Because a derived field is defined entirely in terms of specification fields (or other derived fields), method specifications do not need to state a method's effects on a derived fields. For example:


  /**
 * Represents a square.
 * @specfield length : int // The length of the square's sides
 * @derivedfield area : int // area = length^2. The area of the square
 *
 * Abstract Invariant:
 *  length > 0
 */
class Square {

  /** The length of the square's sides. */
  int size;

  // Abstraction Function:
  //  AF(r) = a square, s, with s.length = r.size.
  //
  // Representation Invariant:
  //  size > 0

  /** Creates a new Square with length = len.
   * @requires len > 0
   * @effects a new Square s with s.length = len
   */
  public Square(int len) {
    if (len <= 0) throw new IllegalArgumentException(len + " < 0");
    this.size = len;
  }

  /** Returns the difference in area between this and s.
   * @return this.area - s.area
   */
  public int differenceInArea(Square s) {
    return (this.size*this.size) - (s.size*s.size);
  }

  /** Sets this.length to len.
   * @requires len > 0
   * @effects sets this.length to len
   */
   public void setLength(int len) {
     if (len <= 0) throw new IllegalArgumentException(len + " < 0");
     size = len;
   }
}



  Notice how the method specification of differenceInArea uses the derived field area to make it easier to explain what it returns.


  It is never necessary for a method specification to indicate its effect on a derived specification field because the class documentation has defined the derived specification field in terms of specification fields. Since area is a derived field, the constructor does not need to say what the newly constructed Square's area is. Similarly, the method specification for setLength does not need to document its effect on area.


  When we relate concrete implementations to abstract values using Abstraction Functions, we will similarly only need to describe the abstraction in terms of specification fields and then the derived fields will follow from the specification fields.


  Note that one could have made area a specification field instead of a derived field. This would relieve the programmer from the responsibility of documenting how area can be derived from the specification fields. However, in this case, the constructor and setLength would be required to specify their effects on area.


  Suppose you have a derived specification field f. It is permissible for there to be a concrete field in the implementation that stores the value of f, or for there to be a method that computes the value of f, or for there to be no such field or method. That is an implementation detail that is of no interest to clients of the specification.




  [bookmark: Method_Specifications]Method Specifications


  Method specifications describe the behavior of a method in terms of its preconditions and postconditions. Note that method specifications may only refer to specification fields, method arguments, and global variables (also known as public static fields), never to the concrete fields of the implementation.


  [bookmark: Preconditions]Preconditions


  Preconditions are properties that must be true when the method is called. It is the responsibility of the caller to guarantee that these properties hold. If the preconditions do not hold, the method is allowed to behave in absolutely any fashion, including crashing the program, continuing with incorrect results, informing the user of the problem, or gracefully recovering from the problem. Callers should always assume that preconditions are not checked by a method. However, it is good practice — though not required — for an implementation to check its preconditions (if the check can be performed efficiently) and throw an exception if they are not satisfied.


  Preconditions are indicated by the "requires" clause in a method specification. If a "requires" clause is omitted from the method specification, it is assumed that the method does not have any preconditions.


  
    	requires (default: no constraints)


    	The preconditions that must be met by the method's caller

  


  [bookmark: Postconditions]Postconditions


  Postconditions are properties that a method guarantees will hold when the method exits. However, if the precondition did not hold when the method was called, then nothin else is relevant, and the method may behave in any fashion whatsoever. In particular, if the precondition does not hold upon method entry, then the postcondition need not hold on method exit.


  A postcondition can be written as a single complex logical formula, but it is convenient to separate it into logically distinct parts. CSE 331 uses "return", "effects", "throws", and "modifies". (In the descriptions below, "default" indicates what is assumed if that clause is omitted from the method specification.)


  
    	return (default: no constraint on what is returned)


    	The value returned by the method, if any


    	throws (default: none, which means that no exceptions are ever thrown)


    	The exceptions that may be raised, and under which conditions.   The specification should not make guarantees about the behavior when the preconditions are not satisfied.


    	modifies (default: nothing, which means that there are no side effects)


    	Variables whose value may be modified by the procedure: They are not guaranteed to be modified, unless otherwise indicated by the effects clause. If object x has specification fields f, g, and h, then "modifies x" means that any combination of x.f, x.g, and x.h might be modified. "modifies x.g, x.h" would be more restrictive. Often, programmers are more interested in quantities that are not listed in the modifies clause, since those are guaranteed not to be changed by the method.


    	effects (default: true, which means "can have any effect" on the references listed under modifies)


    	The side effects of the method, such as changes to the state of the current object, to parameters, or to objects held in global variables: If a specification field is listed in the modifies clause but not in the effects clause, then it may take on any value allowed by the abstract invariants of this class of objects. The difference between the modifies and effects causes is that modifies lists everything that may change and effects indicates what changes occur.

  


  [bookmark: UsingSpecFields]Using Spec Fields for Specifications


  Specification fields are useful for writing specifications of the ADT's operations. Here's a specification for a method on the Line class:


  /**
 * @requires l.start-point is equal to this.end-point && l != null
 * @return a line segment that is equal to this + l; that is, l appended to this
 */
public Line add(Line l) {...}



  Specifications may refer to specification fields (such as start-point and end-point), but never to representation fields. Rep fields depend on a particular implementation, so we don't want to expose them in a specification, which can be implemented in many different ways.


  [bookmark: UsingDerivedSpecFields]Using Derived Spec Fields for Specifications


  When you're writing specifications for operations, you may find it useful to use derived spec fields. A derived spec field is just a spec field that can be written in terms of other spec fields. In other words, it's a shorthand. You can freely use derived spec fields in a method specification (and easing such specifications is the point of derived spec fields):


  /**
 * @return true is this.length > l.length
 */
public boolean longer(Line l) {...}



  [bookmark: subclassing]Subclasses and overridden methods


  A subclass often has a different (stronger) specification than its superclass, and often has a larger abstract state than its superclass. When the specification and abstract state are identical to those of the parent (for instance, an implementation of an abstract class), then there is no need to repeat them in the subclass. However, it is helpful to include a brief note indicating that the superclass documentation should be used instead. That note helps readers to distinguish whether the specification is the same, or the author simply didn't document the class.


  When the specifications differ, then you have two options. The first option is to repeat, in the subclass, the full superclass documentation. The advantage is that everything is in one place, which may improve understanding. The second option is to augment the existing specification -- for example, to add a few new specification fields and constraints on them. Whichever you do, make sure that you clearly indicate your approach. 


  Similar rules hold for a method that overrides another method. It is acceptable to leave the Javadoc blank if the specification is identical. (The generated HTML will use the overridden method's Javadoc documentation, but a normal Java comment is a good hint to someone who is reading the source code.) Otherwise, it is usually better to give the complete specification. If you merely augment the overridden method's specification, be sure to refer to it in the documentation.
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  [bookmark: Introduction]Introduction


  This handout describes how to document a class's implementation. It relies on you already understanding Class and Method Specifications.


  As an example, we will use the same class, Line as from Class and Method Specifications. Notice that we are now showing Line's implementation because this handout covers documenting a class's implementation as opposed to its specification.


  [bookmark: LineDef]
/**
 * This class represents the mathematical concept of a line segment.
 *
 * Specification fields:
 *  @specfield start-point : point  // The starting point of the line
 *  @specfield end-point   : point  // The ending point of the line
 *
 * Derived specification fields:
 *  @derivedfield length : real // length = sqrt((start-point.x - end-point.x)^2 + (start-point.y - end-point.y)^2)
 *                              // The length of the line
 *
 * Abstract Invariant:
 *  A line's start-point must be different from its end-point.
 */
public class Line {

  /** The x-coordinate of the line's starting point */
  private int startX;

  /** The y-coordinate of the line's starting point */
  private int startY;

  /** The x-coordinate of the line's ending point */
  private int endX;

  /** The y-coordinate of the line's ending point */
  private int endY;

  // Representation Invariant:
  //  ! (startX == endX && startY == endY)
  //
  // Abstraction Function:
  //  AF(r) = a line, l, such that
  //   l.start-point = ?r.startX, r.startY?
  //   l.end-point = ?r.endX, r.endY?

 /**
  * @requires p != null && ! p.equals(start-point)
  * @modifies this
  * @effects Sets end-point to p
  */
  public void setEndPoint(Point p) {
    ...
  }

  ...

}



  We begin with brief definitions of the concepts this document discusses:


  
    	Concrete Representation


    	How the abstract state of a class is represented within a Java object. For example, line uses four fields with type int.


    	Representation Invariant


    	A condition that must be true over all valid concrete representations of a class. The representation invariant also defines the domain of the abstraction function. In this particular example, Line requires that it is never the case that r.startX == r.endX && r.startY == r.endY, which is a condition imposed by the abstract invariant in the specification. However, representation invariants are not limited to situations where the specification includes an abstract invariant. They apply whenever there are conditions that must be met for the representation to be well-formed or properly defined.


    	Abstraction Function


    	A function from an object's concrete representation to the abstract value it represents. The abstraction function for Line is trivial: A concrete Line instance, r, is mapped to a line, l, having l.start-point equal to ?r.xStart, r.yStart? and l.end-point equal to ?r.xEnd, r.yEnd?.

  


  Representation invariants and abstraction functions are internal documentation of a class's implementation details. A client should not need any of this information to properly use the class. This information is recorded to help with implementing, testing, debugging, modifying, and extending the class. Therefore, abstraction functions and representation invariants should not appear in a class's description or specification (Javadoc). Instead, the information should appear as internal comments in the class's body (usually using //).


  This document starts by telling how to relate a class's concrete representation to what it abstractly represents through the use of representation invariants and abstraction functions. Then it provides two examples of these concepts and the concepts presented in Class and Method Specifications. Finally, it ends with some general hints for writing understandable documentation.


  [bookmark: RepInvariants]Rep Invariants


  A rep invariant RI maps the concrete representation to a Boolean (true or false). Formally,


  
    RI: R ? boolean

  


  where R is the set of rep values. The rep invariant describes whether a rep value is a well-formed instance of the type.


  The comment describing a rep invariant may explicitly emphasize the functional aspect of RI:


   // Rep invariant is
 //    RI(r) = r.name != null && r.balance ≥ 0


  More commonly, however, we just drop the RI(r) detail and simply write the rep invariant as a predicate that must be true of this:


   // Rep invariant is
 //    name != null && balance ≥ 0


  A rep invariant may mix concrete Java syntax (rep field references, method calls, instanceof, !=, ==) with abstract mathematical syntax (sequence/set/tuple construction, for all, there exists, summation, =). A rep invariant may also be simple English, of course, as long as it is unambiguous. Here are some examples:


   //    for all i, transactions[i] instanceof Trans

 //    suit in {Clubs,Diamonds,Hearts,Spades}

 //    string contains no duplicate characters

 //    size = number of non-null entries in array



  If the rep uses other ADTs, it may refer to them either by their spec fields or by their operations. For example, suppose the Trans type has a spec field amount that is accessible by the operation getAmount. Then the rep invariant for Account (which uses Trans objects) might look like this:


  (1)   //    balance == sum (for all i) of transactions[i].amount


  or this:


  (2)   //    balance == sum (for all i) of transactions[i].getAmount()


  or even this (since transactions is an instance of an ADT with a get operation):


  (3)   //    balance == sum (for all i) of transactions.get(i).getAmount()


  All these are equivalent. But it's important to keep in mind that amount in (1) above refers to a spec field in Trans, not to a concrete field. Unless Account and Trans are cooperating very closely, it isn't appropriate for Account to break the abstraction barrier and refer to the rep fields of Trans directly. By contrast, it's perfectly normal for Account's rep invariant to refer directly to Account's rep fields.


  [bookmark: ChoosingRepInvariant]Choosing the Rep Invariant


  Writing down a rep invariant is tremendously useful for testing, debugging, and writing correct code. It's essential for maintainers: programmers who come back to fix or enhance the code later. The most common problem with rep invariants is incompleteness — leaving out something important. (Leaving out the rep invariant entirely is probably the most common example of this problem!) So here are some hints that will help you fill out your rep invariants.


  Look for rep values on which the abstraction function has no meaning. The abstraction function is often a partial function, meaning that it isn't defined for some possible values of the representation R. The rep invariant must exclude any such values. Recall the Card example from above:


  public class Card {
    private int index;

    // Abstraction function is
    //    suit = S(index div 13)   where S(0)=Clubs, S(1)=Diamonds, S(2)=Hearts, S(3)=Spades
    //    value = V(index mod 13)  where V(1)=Ace, V(2)=2, ..., V(10)=10, V(11)=Jack, V(12)=Queen,
    //                                   V(0)=King
   ...
}


  In this case, the abstraction function isn't defined when the suit number, index div 13, is anything but 0, 1, 2, or 3. So that rules out values of index less than 0 or greater than 51:


      // Rep invariant is
    //    0 ≤ index ≤ 51



  Make sure you don't restrict the rep invariant so much that the abstraction function no longer covers the entire abstract value space A! If you do that, you'll no longer be implementing the abstract type, since some abstract values will be unrepresentable. Here, a little thought convinces us that index still represents 52 cards, all distinct.
 
  Look for rep values on which your methods would produce the wrong abstract value. Consider a class CharSet that represents a set of characters using a mutable string:


  /** CharSet represents a mutable set of characters. */
public class CharSet {
    private StringBuffer chars;

    // Abstraction function is
    //    { chars[i] | 0 ≤ i < chars.size }
    ...

    /** @modifies this
     *  @effects this_post = this - {c}
     */
    public void remove (char c) {
        int i = chars.indexOf(Character.toString (c));
        if (i != -1) chars.deleteCharAt (i);
    }
}


  This implementation of the remove method works only if there are no duplicates in the string, because it only deletes the first occurrence of c that it finds. Notice that the abstraction function is fully defined on R here — it doesn't care whether or not there are duplicate characters, because the set construction syntax implicitly ignores them. But we need the rep invariant to ensure that remove always results in the correct abstract value, i.e. a set that does not contain c.


  Look for constraints required by the data structures or algorithms you've chosen. As examples, an array must be sorted in order to use binary search, a tree cannot have cycles, and two tree nodes cannot share the same child.


  Look for fields that need to stay coordinated with each other. In a bank account, for example, the balance and the sum of the transaction amounts should always be in sync. In a linked list, the size field always needs to reflect accurately the number of nodes in the list.


  Look for rep values that would cause your code to throw unexpected exceptions. A conventional part of every rep invariant is a set of fields that shouldn't be null, so you won't have any NullPointerExceptions when you use them later:


      //   name != null && transactions != null


  Make sure your constructors and producers actually establish the rep invariant, though. That means, if any of these fields are initialized from parameters, you have to check for null before you put them in the rep.


  Some other exceptional conditions you should think about:


  
    	division by zero


    	index out of range


    	class cast exception

  


  Look for constraints imposed by the application domain (on abstract values). In a bank account, the balance should always be non-negative. (Or even stronger: the partial sums of the transaction amounts must all be non-negative, to guarantee that the balance never went negative in the past.) In chess, two bishops of the same color should not be on squares of the same color (unless a pawn has reached the end of the board and been promoted to a bishop).


  Assuming they refer only to properties of the abstract values (like spec fields), these kinds of constraints do not just apply to the rep. They are in fact abstract invariants. Abstract invariants should be documented for the client of the data type, so put them in your class overview. But when abstract invariants exist, they very often imply constraints that need to be included in the representation invariant. If you omitted these from the rep invariant, then your type would represent abstract values that aren't well-formed.


  [bookmark: Checking]Checking the Rep Invariant at Run Time


  Many rep invariants can be translated straightforwardly into code. If that's the case, do it! Having an executable rep invariant, and using it at run time, not only helps find bugs in the code quickly; it also checks for mistakes in the rep invariant. Sometimes the rep invariant you've written is too strong, making assumptions that are unwarranted and unnecessary. Actually testing the invariant against running code is a good sanity check.


  The rep invariant checker can be coded as a method checkRep of no arguments that throws an exception if the rep invariant is violated, preferably with a message indicating which constraint was broken. (However, a specification never mentions the representation invariant; from a client's point of view, the method never has any effects.) Here's an example:


  private void checkRep () {
    if (balance < 0)
        throw new RuntimeException ("balance should be ≥ 0");

    if (name == null)
        throw new RuntimeException ("name should be non-null");

    // for all j, sum (i=0..j) transactions[i].amount >= 0
    int sum = 0;
    for (Trans t : transactions) {
        sum += t.getAmount();
        if (sum < 0)
           throw new RuntimeException("balance went negative");
    }
    // balance = sum (for all i) transactions[i].amount
    if (balance != sum)
        throw new RuntimeException ("balance should equal sum of transactions[i].amount");
}


  The best place to put checkRep in your class is right after your fields. You can either write your rep invariant as a separate comment, or intersperse the constraints of your rep invariant as exception messages in checkRep (as was done above). The latter approach is probably better, because it makes it more likely that the comment will be kept current with the code in checkRep. Any part of the rep invariant that you can't write as executable code, just leave as a comment.


  Assertions provide an even cleaner way to write checkRep, because they handle the test and exception for you. Here are two ways to do it:


      // using Java assert syntax
   assert balance ≥ 0 : "balance should be ≥ 0";

    // using junit.framework.Assert (you don't have to be writing a unit test to use this class)
    Assert.assertTrue ("balance should be ≥ 0", balance ≥ 0);



  Calls to checkRep should be placed at the start and end of every public method, and at the end of every constructor. Put a call to checkRep at the end of observers, even if you think they don't change the representation (since you may be wrong). Private methods generally don't call checkRep, because private methods may be designed to be called while the rep is in an intermediate state that doesn't satisfy the rep invariant.


  If part of the rep invariant is very expensive to check, you may want to turn that part off in the release version. Otherwise it makes sense to leave it in. Be careful how you judge performance here. Novices are often much too ready to worry about performance improvements that turn out to be negligible. Before dropping a check, you should have some evidence that it's expensive, such as an analysis with a profiler showing that indeed the check is a hotspot, or a theoretical argument, for example that the check turns a constant time operation into a linear time one. Checking fields against null is always a constant time operation; there's no reason to drop this check except in absolutely performance-critical code. Summing all the transactions in an account is linear in the number of transactions, which you might not want to do for every method call in production code. But even expensive checkReps are usually justified during testing and debugging; they'll more than pay for themselves in reduced debugging time unless they make executions not complete in any reasonable amount of time (e.g., days or centuries). An easy way to enable/disable the checkRep invocation is to add a static boolean variable named debug to the class, and either check that variable within checkRep or write calls like if (debug) checkRep();. Then, you can disable all the debugging checks by just changing the variable's value.


  The checkRep method can also be made public, so that unit tests can call it during testing. checkRep is normally private, since the representation is not part of the specification; clients aren't supposed to be aware that there's a rep under the covers that might be broken. (Horrors!) But it doesn't expose the rep if you make it public. If your class is working properly, then from the client's point of view, checkRep is just a no-op: it changes nothing and never throws an exception. If you make checkRep public, you should probably specify it that way, so that clients don't bother calling it unless they're paranoid: "This operation does nothing unless there's a bug, in which case it (sometimes) throws an exception." Needless to say, don't put the rep invariant itself in the spec for checkRep. That's representation-dependent.


  [bookmark: Not-in-rep-invariont]What Not to Write in the Rep Invariant


  Your rep invariant does not have to mention facts that are impossible in the rep. You are allowed to rely on the guarantees of the ADTs in your concrete fields. For example, if one of your concrete fields is an int, your rep invariant shouldn't mention that its value is less than or equal to Integer.MAX_VALUE or that it is not null. Likewise, if one of your concrete fields is a set, your rep invariant needn't mention that it contains no duplicates.


  This is similar to the way that a method precondition does not need to mention properties that are guaranteed by the ADTs of the formal parameters.


  The rep invariant should be expressible as a checkRep method. Don't write anything in the rep invariant that cannot be checked by just examining the concrete representation. Checking the rep invariant should not require any knowledge of what the representation means nor of what operations were performed to create the representation.


  [bookmark: AbstractionFunctions]Abstraction Functions


  An abstraction function AF maps the concrete representation of an abstract data type to the abstract value that the ADT represents. Formally,


  
    AF: R ? A

  


  where R is the set of rep (representation) values, and A is the set of abstract values. You can think of an element in R as the Java object. A, on the other hand, exists only in our imagination, and has no existence inside the computer. For example, if this is the ADT:


  class Complex {
  private double real;
  private double imag;
  ...
}



  then the rep space R is the set of Complex objects, and the abstract space A is the set of complex numbers.


  [bookmark: WhereAreRAndADefined]Where Are R and A Defined?


  The rep space R is obvious: it's defined by the fields you put in your class. You can't possibly implement an abstract data type without fields, so you'll never forget this. The abstract value space A, however, is not represented in code. It should be documented in your class overview (see Abstract State), because both clients and implementors want to know what abstract type the class represents:


  /**
 * Complex represents an immutable complex number.    ← this is A
 */
public class Complex {
  private double real;    ← these fields form R
  private double imag;
  ...
}



  Whether the type is mutable or immutable is a crucial property that should be mentioned in the class overview.


  [bookmark: AF]AF(r)


  Technically, an abstraction function is a function. This is why you may see it written using functional notation, AF(r):


  /**
 * Complex represents an immutable complex number.
 */
public class Complex {
  private double real;
  private double imag;

  // The abstraction function is
  //      AF(r) = r.real + i * r.imag
  ...
}


  The r in AF(r) represents an element in the rep space. In other words, it's a reference to a Complex object. So we can refer to fields of the object r on the right-hand side of the abstraction function. (Incidentally, r stands for representation.) 


  The functional notation is essential when the abstraction function is recursive, since we need some way to refer to it on the right-hand side:


  /**
 * Cons represents an immutable sequence of objects.
 */
public class Cons {
  private Object first;
  private Cons rest;

  // The abstraction function is
  //      AF(r) = [] if r = null
  //              [r.first] : AF(r.rest) if r != null
  ...
}


  (The square brackets and colons are sequence construction syntax.)


  However, usually the abstraction function isn't recursively defined. Then it's more readable just to write the right-hand side. We further assume that the rep object r represents this, and adopt the convention of dropping references to this when writing the abstraction function:


  /**
 * Complex represents an immutable complex number.
 */
public class Complex {
  private double real;
  private double imag;

  // The abstraction function is
  //      real + i * imag
  ...
}



  This is simple and clear, but remember that it's just shorthand for AF(r).


  For ADTs with trivial reps, the spec fields may correspond one-to-one with rep fields:


  public class Line {
    private Point start;
    private Point end;

    // Abstraction function is
    //    AF(r) = line l such that
    //       l.start = r.start
    //       l.end = r.end
    ...
}



  But this abstraction function is hardly worth writing down. Here's a more interesting rep for the same ADT:


  public class Line {
    private Point start;
    private double length;
    private double angle;

    // Abstraction function is
    //    AF(r) = line l such that
    //       l.start = r.start
    //       l.end.x = r.start.x + r.length * cos(r.angle)
    //       l.end.y = r.start.y + r.length * sin(r.angle)
    ...
}


  Note that x and y are spec fields of the Point type. It was convenient to define the point end in terms of its spec fields as well.


  Let's simplify this with some more shorthand. We'll drop the AF(r), as we did earlier. We'll assume that the rep value r and the abstract value l both represent this — just different aspects of this — and adopt the convention of dropping references to this. The effect of all this shorthand is just a list of equations defining each spec field in terms of the concrete fields:


      // Abstraction function is
    //       start = start
    //       end.x = start.x + length * cos(angle)
    //       end.y = start.y + length * sin(angle))



  Keep in mind that on the left-hand side, start refers to a spec field; on the right-hand side, start refers to a concrete field. (x and y always refer to spec fields here, because the rep of the Point type isn't visible to us.) Isn't there a danger of confusion between the two starts? Not really. We gave the spec field and the concrete field the same name for good reason — because they are equated by the abstraction function. Do we really have to say start=start explicitly in the abstraction function? Probably not. If the spec field start and the rep field start weren't equated by the abstraction function, then we should have given them different names. Remember that your goal in these kinds of specifications is not formal communication with a machine, but clear and unambiguous communication with other human beings (Not only the author(s)!).  Names matter.  Sometimes abbreviations help, and sometimes they do not.


  Here's another example. Suppose we want to represent a Card data type, in a poker game, using a single integer in a field index. We might have two specification fields, suit and value:


  /**
 * Card represents an immutable playing card.
 * @specfield suit : {Clubs,Diamonds,Hearts,Spades} // card suit
 * @specfield value : {Ace,2,...,10,Jack,Queen,King} // card rank
 */



  The abstraction function then describes how to peel apart the index field into a suit and a value:


  public class Card {
    private int index;

    // Abstraction function is
    //    suit = S(index div 13)   where S(0)=Clubs, S(1)=Diamonds, S(2)=Hearts, S(3)=Spades
    //    value = V(index mod 13)  where V(1)=Ace, V(2)=2, ..., V(10)=10,
    //                                   V(11)=Jack, V(12)=Queen, V(0)=King
    //    (div and mod refer to the integer division and remainder operations)
    //    for example, 3 ? Three of Clubs
    //                 14 ? Ace of Diamonds
   ...
}



  This abstraction function maps each representation object to a pair (suit,value), but rather than writing it as a single function, we've specified it as two separate ones, one for each specification.


  (Two incidental points: you may wonder why Ace is V(1) instead of V(0). This was done to make the abstraction function more direct on the numbered cards, so that V(i) = i for 2 through 10. But it may not be ideal; since King is V(0), we can't compare cards by comparing the index field directly. Second, this representation of Card is tightly coupled to the set of suits and the set of values. If we expect those types to change in the future, e.g., adding or removing suits, then we would have to change the representation of Card. For some applications, however, the compactness of the representation may be worth the disadvantages of greater coupling.)


  Example 1: Card


  Here's a complete example of a simple class with an abstraction function and a rep invariant, so you can see one way you might structure your code.


  /**
 * Card represents an immutable playing card.
 * @specfield suit : {Clubs,Diamonds,Hearts,Spades} // card suit
 * @specfield value : {Ace,2,...,10,Jack,Queen,King} // card rank
 */
public class Card {

    private int index;

    // Abstraction function is
    //    suit = S(index div 13)   where S(0)=Clubs, S(1)=Diamonds, S(2)=Hearts, S(3)=Spades
    //    value = V(index mod 13)  where V(1)=Ace, V(2)=2, ..., V(10)=10, V(11)=Jack, V(12)=Queen,
    //                                   V(0)=King

    // Rep invariant is
    //    0 <= index <= 51

    /**
     * Check the rep invariant.
     * @effects: nothing if this satisfies rep invariant;
     *           otherwise throws an exception
     */
    private void checkRep() {
        if (index < 0 || index > 51)
            throw new RuntimeException ("card index out of range");
    }

    /**
     * @effects makes a new playing card with given suit and value
     */
    public Card(CardSuit suit, CardValue value) {
        ... // initialize Card
        checkRep();
    }

    /**
     * @effects returns this.suit   ← "suit" refers to the spec field
     */
    public CardSuit getSuit() {
        checkRep();
        try {
            CardSuit s = ... // decode suit
            return s;
        } finally {
            checkRep();
        }
    }

    /**
     * @effects returns this.value  ← "value" is the spec field
     */
    public CardValue getValue() {
        checkRep();
        try {
            CardValue v = ... // decode value
            return v;
        } finally {
            checkRep();
        }
    }

    ...
}



  The checkRep() calls in all the observers are probably unnecessary in this case, since the class is simple, immutable, and clearly has no rep exposure. They're included anyway to illustrate what you would want to do in a more complex class.


  Example 2: Stack


  Suppose we wanted to implement a Stack ADT with an array.


  The Representation Invariant


  Here are some possible representation invariants:


  public class Stack {
    private int[] elements;

    // Abstraction function:
    //    The Nth element from the bottom of the stack = elements[N-1]
    //    where the 1st element is at the bottom

    // Rep Invariant:
    //    For any index i such that 0 <= i < size, elements[i] != null

    // OR

    // Rep Invariant:
    //    elements never contains a null value
}



  One can imagine a slight change if the RI was for a SortedStack:


  public class SortedStack {
    private int[] elements;

    // Abstraction function:
    //    The value considered 'least' in the stack = elements[size-1]
    //    ...
    //    The value considered 'greatest' in the stack = elements[0]

    // Rep Invariant:
    //    For any index i such that 0 <= i < size: elements[i] != null 
    //    For any index j such that 1 <= j < size: elements[j] <= elements[j-1]
}



  In this case, our RI is distinguishing limitations on the internal state of our ADT.


  The purpose of the RI: to define valid and invalid internal states for this ADT object (a SortedStack should always be sorted and never contain a null value). The checkRep() method should mirror the RI.


  The Abstraction Function


  Here are some example AFs.


  // For a naive implementation with poor run-time performance:
public class Stack {
    private int[] elements;
    private int size;

    // Abstraction function:
    //    The top element of the stack = elements[0]
    //    The second-from-the-top element of the stack = elements[1]
    //    ...
    //    The bottom element of the stack = elements[size-1]

    // OR

    // Abstraction function:
    //    The Nth element from the top of the stack = elements[N-1]
    //    where the 1st element is at the top
}



  // For a tweaked implementation with great run-time performance:
public class Stack {
    private int[] elements;
    private int size;

    // Abstraction function:
    //    The top element of the stack = elements[size-1]
    //    The second-from-the-top element of the stack = elements[size-2]
    //    ...
    //    The bottom element of the stack = elements[0]

    // OR

    // Abstraction function:
    //    The Nth element from the bottom of the stack = elements[N-1]
    //    where the 1st element is at the bottom
}



  Notice that the signature and fields of both examples are identical, but each abstraction function suggests different implementations with dramatically different run-time performance. (If its unclear why the run-time performance is different, think about what needs to happen to the elements in each implementation's array when pushing and popping from the stack.)




  [bookmark: Subclasses]Subclasses


  Abstraction functions and representation invariants are implementation-specific. Therefore, it does not make sense to inherit them from a superclass. When you write a subclass, you should define its abstraction function and representation invariant from scratch and write it out in full.


  [bookmark: GeneralHints]General Hints on Readability


  Remember that the reader of your specifications, abstraction functions, and rep invariants is most likely going to be a human being, not a program. It might be a teammate trying to find a bug in the code; a maintainer charged with updating the software after you've left the company; or even yourself, six months (or days!) later, trying to remember how this program worked.


  So formal syntactic correctness is actually less important than simplicity and clarity. That doesn't mean you should sacrifice semantic precision, or leave things ambiguous or undefined. But it does mean that you should think twice about writing something like this:


      // Abstraction function is
    //    <[x,y],s^[for all 0<i≤chars.size(), chars[chars.size()-i]]> | x=front.rest,
    //     y=back.first, s=n.toString()>


  A compiler might enjoy reading this (if the compiler were actually reading your abstraction function). A human would stare at it and curse.


  Here are some tips for making your abstraction functions and rep invariants more readable:


  
    	Introduce new names where they're useful: 

        AF(r) = list l such that...


    AF(r) = c_0 + c_1*x + c_2*x^2 + ...

        where c_i = ...



  


  
    	Use spec fields: 

        suit = ...
    value = ...



    	Provide examples: 

     for example, 3 ? Three of Clubs




    	Introduce new functions where they're useful: 

     reverse(back)



    	Use plain language wherever it's unambiguous and clearer or more concise than formal syntax: 

        chars contains no duplicates



 Contrast this with the formal alternative: 

        for all 0≤i<j<chars.size, chars[i] != chars[j]
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  Testing increases our confidence that our code behaves correctly (i.e., meets the provided specifications). However, testing can only prove that errors do exist, not that a program is free from errors. In practice, testing is often the most practical and effective way to find bugs in your program.


  Debugging is a distinct activity from testing. 


  Types of Tests


  Tests can be classified in various ways, according to:


  
    	How much code is tested: unit tests vs. system tests


    	The level of specifications being tested: specification tests vs. implementation tests


    	Whether you know the implementation when you are writing your tests: black box tests vs. clear box tests

  


  How much is tested


  A unit test is a test for one component. If a unit test fails, you don't have to spend a lot of time localizing the defect, because you know exactly where the defect is: in the component being tested. Unit tests help you ensure that you are building your system out of reliable building blocks. Commonly, a unit test tests one method of one class. However, a test can be a unit test if it focuses its attention on one class, or one package — so long as that is smaller than the overall system being tested.


  System tests or integration tests are tests of whether the system as a whole works — whether the (individually correct, unit-tested) modules fit together to achieve correct functionality. A system test usually involves more complicated operations than unit tests. An example is the practice of reading in a file that defines some operations, performing those operations, writing out a result file, and comparing the result file to a version (called the goal file or golden file) that has been hand-inspected and verified to be correct.


  You should run unit tests first, and then system tests only when all the unit tests succeed. It is often a good idea to write system tests first, even before you know how you will modularize your implementation.


  The level of specifications being tested


  When you write a component, you write it to satisfy some externally-visible need, and it has behavior that clients can depend on. This is its specification. The tests that you deliver with your system help a client to have confidence that your implementation meets its public specification.


  The implementation might actually satisfy a stronger specification.


  
    	The implementation may be designed to strengthen some parts of the public specification. For example, a routine that is allowed to return a list in arbitrary order might always return the list in sorted order. Or, an implementation might have well-defined behavior for inputs that are outside the public precondition (requires clause).


    	An implementation might have more components than the specification requires. For example, a class might have additional methods. Or, the implementation might have helper classes. Each helper class has its own specification, but the client is not aware of, nor can the client use or depend on, these helper classes.

  


  The client cannot depend on extra properties of the implementation, and generally doesn't even know them! However, you might like to ensure that your implementation satisfies those properties, as a double-check that it meets your design. Such tests should not be exposed to the client — they are an internal debugging aid for the implementor.


  Another way to think of this is that specifications have different levels of visibility. For example, a client may only care that files are read and written in a specific format. This forms one level of specification. In designing the program to read and write these files, engineers should write specifications for each public method in each class they use (i.e., via Javadoc-style code comments). This forms another level of specification, which is stronger than the client's specification. You should test your code at each level of specification.


  In CSE 331, any tests on the level of the client's (the staff's) specification should be called by SpecificationTests.java. Any tests for specifications not handed out by the staff (the ones that you design) should go in ImplementationTests.java.


  Here is a good guideline: If your test could compile and run as a valid test against any other student's code, then it should go in SpecificationTests.java. Otherwise, it should go in ImplementationTests.java.


  If the implementation changes, your implementation tests may become invalid. However, your specification tests will remain valid so long as the specification does not change. They remain valid, but you might want to add new black-box specification tests to ensure that you specification tests have good coverage of your implementation.


  You should generally write specification tests first. Then, add implementation tests to cover important functionality that is not covered by your specification tests. Sometimes, a component does not need implementation tests because there isn't anything extra about the implementation that is not covered by the specification tests; that's fine, and you need not duplicate test functionality. Sometimes, a component does not have specification tests because it is not visible in the specification.


  Do you know the implementation?


  Black box tests


  Black box tests are written without knowledge of anything except for a specification.


  Their advantage over clear box tests is that they are unlikely to be biased by the same misunderstandings with respect to the specification that might have caused a bug in the implementation. In many circumstances, black box tests are written by people who are not the ones who write the implementation. Black box tests can be written before, or concurrently with, the implementation.


  Black box tests should be written first, but they are typically not sufficient on their own. A black box test may not cover (that is, exercise or execute) all parts of an implementation, and therefore it may miss bugs.


  They also fail to test specifics of the implementation where the implementation is stronger than the specification. (Doing so requires writing an implementation test.)  


  Clear box tests


  Clear box tests are written with full knowledge of an implementation.


  Clear box tests of the specification have the advantage of being able to test that special cases in the implementation conform to the specification, even if those cases are not particularly special according to the specification alone.


  The disadvantage of clear box tests is that people are likely to make the same mistakes when writing the clear box tests as they made when writing the methods that are being tested. This can result in the tests passing when the specification is not actually being accurately followed. Also, if an implementation changes, then the lcar-box specification tests remain valid tests, but they may no longer provide good coverage.


  Discussion


  A black box test and a clear box test are testing the same specification. Each one is valid for any implementation of that specification. The only difference is the methodology you used for deciding the test inputs. It is perfectly fine to re-use clear box tests when your implementation changes. (Why throw away tests?) You probably need to add some additional clear box tests to ensure good coverage of the new implementation, however.


  You should write black box tests first, and then add clear box tests as needed if there is implementation behavior that is not exercised by the black box tests.


  Relating the ways to classify tests


  The notions of unit vs. system testing, specification vs. implementation testing, and black box vs. clear box testing are completely orthogonal. You can have all 8 varieties of tests — though you probably won't explicitly segregate all those 8 varieties in your test suite.


  Oftentimes but not always, unit tests are implementation tests and system tests are specification tests. However, it is possible to have a unit specification test (if the specification is sufficiently detailed), and to have a system implementation test (if your implementation has a stronger overall specification than the public documentation requires). Black-box and clear-box approaches for generating test input data are always appropriate, no matter the other details about your tests.


  How to test a private method


  Tests are written in a separate class from the code being tested — this separates distinct concerns, and it keeps the tests from cluttering the code. However, this makes it impossible to directly test private methods, which are not accessible outside the class in which they appear. (When the tests are in a separate package than the code being tested, a similar problem occurs for methods with protected or default accessibility. In JUnit 4, it's possible to test protected (but not private) methods of non-final classes by using subclassing.)


  Suppose you want to test a private method. There isn't really a good way to do this. Four approaches are suggested by Bill Venners. (This is a rewording of his summary, for clarity.) The first one tests the private methods indirectly, and the last three test the private method directly.


  
    	Devise tests of the public methods that exercise all the functionality of the private methods.


    	Make the methods non-private, and write normal tests.


    	Write the tests inside the class, where they have access to the private method.


    	Use reflection to circumvent Java's access restrictions on private methods.

  


  We recommend the first approach. It creates a specification test that will continue to be useful even if your implementation changes. Since the private method is designed for a particular, specific purpose, it should be possible to exercise all its functionality just via calls to the public methods. If there is more functionality in the private methods, then it is irrelevant to the behavior of the system, and it should perhaps be removed.


  To use the third approach, you would write the tests in the same class as the method itself, in a method with greater visibility. For instance, to test private method foo, you would write a public method named testFoo. The specification of testFoo is the same as that of checkRep (another public method that tests private, inaccessible details of the class). Each of these takes no arguments and return no results, but throws an exception if any of its tests fail.


  Other approaches are less desirable. Making the method public breaks modularity, and clients could come to depend on it, restricting the flexibility of the implementer. Using reflection to temporarily make the method public is ugly and hard to understand. Not testing the method is even worse, as bugs in a helper method may be much harder to debug when they are exposed only by incorrect behavior of a method that calls them.


  If you choose to test the private methods directly, using one of the last three approaches, then be sure to put those in your implementation tests, not your specification tests.


  Additionally, it's always a good idea to write assertions (including checkRep) within all your methods. Writing assertions is orthogonal to writing test cases.




  Testing Methodology


  Before you start writing code


  
    	Use the specification to identify the abstract-value domain of each non-trivial public method: what is the set of objects that the method can be called on, and the set of allowed inputs?


    	Partition each domain into "similar cases." For example, if the domain contains a number, does the method operate only on positive numbers, odd numbers, etc...?


    	Write black box unit tests for each non-trivial public method in SpecificationTests.java.

  


  As/after you write your implementation


  
    	As one of the first things you implement, write a private checkRep() method and call it on entrance and exit from every non-trivial public non-constructor method (and on exit from all constructors). If you use only immutable objects and final fields, then you can just call checkRep() after the constructor.


    	Whenever reasonable, write clear box tests for both your specification and implementation in ImplementationTests.java.

  


  Hints for testing


  
    	In the contructor for the class defining the test suite, do not include (defining or running) any actual tests. In fact, the test-suite constructor should not even construct instances of the class(es) being tested — leave that to the code defining the tests. The test-suite constructor should set up only any bookkeeping useful across all the tests and it is fine if there is not any.


    	Write small tests. That way, if the test fails, you will have an idea of what was happening at the time.


    	Choose good names for your tests, use the proper instance of the assert method, and write good messages. This will ensure that all the information you need to debug a test failure is present.


    	Think carefully about each test. Don't write a specification test but accidentally call it an implementation test. Don't just use your solution as an oracle, but think carefully whether alternative solutions are correct (e.g., is there more than one shortest path for the given graph?).


    	Remember that testing requires writing clear, concise, and targeted tests, not just coming up with an arbitrary number of random examples.

  


  Test code reuse


  Just as abstraction and re-use are good in your program, they are also good in your tests. We encourage you to re-use!


  Just be careful that you do not end up obscuring the cause of an error. That could happen because you have no test that tests one particular method in isolation, so it is hard to isolate the code error (or the error in the test). If you build up your tests carefully, you can avoid this problem.
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  Introduction


  Debugging is the process of understanding why your code is erroneous, then fixing the code. You typically begin debugging after you have written tests and one of the tests fails, or after a user reports a bug to you.


  You should think of debugging as several separate steps:


  
    	determine what part of your code is defective


    	determine why that code is defective


    	change the code to fix the defect

  


  This document addresses each of these three steps in turn.


  Localizing the failure


  To “localize” a failure is to determine which parts of your code might be defective and which are correct, so that you can focus your attention just on the places the defect might be.


  1. Your testing framework, such as JUnit, will generally inform you what test case is failing. Since you know what code is executed by that test case, you have narrowed down the parts of your code that might be buggy.


  You might want to narrow down the problem more. For example, a given test case might execute multiple methods in your code, and you might want to know which one of them is buggy. A less common reason is that the testing framework does not indicate which test fails, which could happen when your code suffers an infinite loop. (See below for more about this situation.)


  A good way to further isolate the problem is by writing more tests. If you have a large test that fails for a reason you do not understand, then create new tests, each of which exercises just part of the functionality of the original test. Then, run those tests to see which part is problematic. An advantage of this is that you can re-run your new tests as often as you like, and they will be of value in the future.


  Another way to isolate the problem is to execute the test step-by-step, manually observe the values it computes, and decide whether those results are correct. This can be a quick way to reduce the scope of your investigation, because it doesn't require you to write new tests. On the other hand, it can be tedious, you can easily make errors, and you may have to repeat that manual effort many times rather than being able to easily re-run a test. It's typically a good idea to start with this “manually observe the execution” strategy — then, if it doesn't yield insight quickly, you should create tests.


  Executing the test step-by-step can be done in several ways.


  
    	Play computer and manually execute your code with paper and pencil.


    	Use the debugger to step through your program one statement at a time, examining the values computed as you go.


    	Add logging (print statements) to your program that output key values, run the program, and then examine the console log with all the output. Common places to add logging are the beginning and end of methods.

  


  Any of these approaches is also useful for debugging an infinite loop. If you use logging, the console output will indicate which functions or tests started but never completed.


  Understanding the failure


  To determine why the test case is failing, your best approach is manual reasoning about all the parts of the code that are executed.


  For example, suppose that you are debugging an infinite loop. What is the decrementing function for the loop? Can you show that it is reduced every time through the loop and that the loop exits when it is minimal? What is the loop invariant? Can you show it is maintained?


  If you are debugging an incorrect computed value, then similar reasoning approaches apply.


  If you have trouble with reasoning, you might find it helpful to execute the test case manually and examine the values computed. This may give you the insight to return to manual reasoning. To execute the test case manually, you can play computer, simulating the execution of the test case with paper and pencil. You can also use the debugger to help with this: the debugger can execute your code one line at a time, which lets you observe your code's execution in a way similar to you playing computer. Playing computer or running the debugger will yield the same result as the actual execution that is freezing up your computer.


  Fixing the bug


  To correct a defect, you should follow the same process as you do when writing code in the first place. In fact, in many cases the best approach, when faced with confusing, buggy code, is to throw it out and start over in a disciplined way with a better design.


  Hints for debugging


  One good way to go about debugging is to construct an argument that states that the output that you saw is impossible. Oftentimes, just stating this argument will make clear where it is wrong. Or, you may find that you can't make the argument, in which case you can determine an input that does produce that output. If you can make the argument, then you can examine it for mistaken assumptions or incorrect logic. If you can make the argument but can't determine why it is incorrect, then you can present it to someone who can help you (such as the course staff).


  In any event, please don't blindly write a lot of tests — this is a terrible use of your time! Instead, follow the scientific method. First form a hypothesis that is grounded in what you know so far, then perform an experiment to test the hypothesis. The experiment might involve writing a test, but don't write a test if you don't have a concrete reason for believing wh